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Protektor32 – Intraoperative Neurophysiological
Monitoring
Indications for Use
The Protektor32 system, composed of both hardware and software, is intended to be used for
intraoperative neurological Monitoring. The instrument uses EEG, EP, EMG and Transcranial Stimulation
techniques (TcMEP) to provide the healthcare professionals with information to help assess a patient’s
neurological status during surgery.
The TcMEP mode is intended for intraoperative diagnosis of acute dysfunction in corticospinal axonal
conduction brought about by mechanical trauma (traction, shearing, laceration, or compression) or
vascular insufficiency.
The EPWorks software, an integral part of the system, is intended to allow a medical professional to
manually configure stimulation and acquisition parameters and to manually create EEG, EP, EMG and
TcMEP protocols according to their own requirements. The intended use for each of the software’s
outputs is as follows:
•

The EEG, EP, and EMG waveforms are intended to help the user assess a patient’s neurological
status during surgery.

•

Simple waveform parameters (e.g., amplitude, latency), and user-defined Fast Fourier Transform
(FFT) displays (CSA, DSA) are intended to help the user analyze the EEG and EP waveforms.

This device is intended to be used by qualified medical practitioners, trained in Electroencephalography,
Evoked Potentials and Electromyography, who will exercise professional judgment when using the
information.

Protocols
As stated by the America Academy of Neurology (2008) “[...] the quality, extent and type of monitoring [...]
is exquisitely reliant on the rigors of the monitoring procedure and protocols, and the clinical expertise of
the monitoring physician.” All things considered, Intraoperative neurophysiological monitoring depends on
the collection of data that will be judiciously interpreted by the trained professional to identify neurological
changes due to operative manipulations.
The Protektor32 offers flexibility to accommodate user needs for intraoperative monitoring. It provides an
easily accessible interface to quickly set up protocols when performing the following intraoperative
monitoring procedures:
•

Central Sulcus Mapping: A method for intraoperative determination of the central sulcus using
SSEP and/or Motor Evoked Potentials.

•

Pedicle Screw Stimulation: A method or technique for monitoring pedicle screw placement and
performed by applying stimulation of the “pedicle screw” and recording the evoked EMG activity from
the muscles innervated by the spinal nerve roots at risk.

•

Direct Nerve Stimulation: A method used to evaluate damaged nerves. It is based on the possibility
to record and analyze a type of evoked potential (EP) called Nerve action potential (NAP) which is a
the total electrical potential that develops and travels within a nerve after its constituent nerve fibers
have been stimulated- either physiologically or physically- to a level above their threshold.

The above reflects TcMEP protocols only as they relate to the intended use of the Protektor32.
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Safety Information
The Protektor32 System is intended for use ONLY by qualified individuals who have received training
on this device. Read carefully this manual and make sure you fully understand all warnings and
cautions, and the procedures to follow before operating the Protektor32 system.
For TcMEP specific warnings and cautions, refer to the section “Using the TcMEP Module on
Protektor 32” in this manual.

Critical Warnings and Cautions
The Protektor32 is intended for use ONLY by qualified individuals who have received
training on this device. This user/service manual should be read and understood fully
before commencing use of the product.
Use of the Protektor32 high-current stimulator for transcranial stimulation can cause biterelated injury. It is imperative that effective preventative measures be implemented
BEFORE using the device for this purpose.

General Warnings
It is the responsibility of the institution where the Protektor32 unit is installed to ensure that
the requirements of IEC60601.1.1-M92 - Collateral Standard: Safety Requirements for
Medical Electrical Systems are fulfilled in the particular installation.
Non-medical electrical equipment (printers and computers) complying with the appropriate
IEC or ISO safety standards may be directly connected to the Protektor32 serial and
network ports for data-transfer functions only if both the Protektor32 and the equipment are
outside of the patient environment and no patient-applied parts are connected to the
patient.
For further details on how to comply with this standard regarding non- Xltek supplied
printers or VGA monitors, please consult the standard or contact Xltek Technical Support
at 1-800-303-0306 or OTS@natus.com.
WARNING: To avoid the risk of electric shock, this equipment must only be connected to a
supply mains with protective earth.
Connecting electrical equipment to a MULTIPLE SOCKET OUTLET (MSO) effectively
leads to creating a MEDICAL ELECTRICAL (ME) SYSTEM and the result can be a
reduced level of safety. For the requirements that are applicable to an ME SYSTEM,
please refer to IEC 60601-1 Ed. 3.1.
Connection of a patient to high-frequency surgical equipment (electrocautery) and to an
electromyograph or evoked response equipment simultaneously may result in burns at the
site of the electrical stimulator or biopotential input part electrodes and possible damage to
the electrical stimulator or biological amplifiers.
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Operation in close proximity (for example 1 m) to shortwave or microwave therapy
equipment may produce instability in the electrical stimulator output.
The device is NOT intended to operate in the vicinity of strong sources of potential
electromagnetic interference such as MRI or CT.
Electrostatic Discharge (ESD) Precaution: Be sure to take the appropriate
Electrostatic Discharge (ESD) precautions. Disconnect the cables before
moving, cabling, or performing any set up procedures. Connectors marked with
the ESD protection symbol should not be touched.
All wires to/from the patient must NOT contact any of the conductive parts of the device
including earth.
Preventive maintenance is required every six months. This should include chassis and
patient leakage current measurements at a minimum.
The device is not protected against defibrillation. All wires to/from the device should be
removed before using a defibrillation.
Do NOT use this device in the presence of implanted electronic devices unless a specialist
medical opinion has been obtained.
Do NOT place the stimulation electrodes such that the stimulation current will be transthoracic (crossing the area of the chest and thorax.)
The Protektor32 headbox carries ordinary classification for the level of protection against
ingress of liquids (IPX0). It is not drip or splash proof.
The Protektor32 headbox requires a properly grounded electrical outlet. The internal
isolation transformer must not be bypassed under any circumstances.
Stimulating electrodes must be large enough so that the current density is always less than
2 mA r.m.s./cm2. Current densities exceeding 2 mA r.m.s./cm2 may require special
attention of the operator. For example, if the stimulus is stimulating at 100 mA at 10 Hz,
with a duration of 1 ms, then the stimulus electrode must be at least 0.5 cm2.
For a detailed description and calculations of the stimulation parameters needed to achieve
less than 2 mA rms / cm2 refer to section Using the TcMEP Module on Protektor32.
When an electrode with a small surface area is used (such as a needle electrode), the
current density rises.
Current density in TcMEP mode is dependent on the stimulation strength (voltage) and
number of pulses. If the stimulation parameters are different from those detailed in the
table and the voltage is greater than these thresholds, it may cause skin burns.
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Patient movement may occur during stimulation, leading to inadvertent neural injury. Take
adequate steps to avoid stimulation when patient movement could cause injury.
The Protektor32 shall be used ONLY with legally-marketed electrodes in the country where
in use. For instance, in the United-States use ONLY FDA-approved, legally-marketed
electrodes. In Canada use ONLY Health Canada-approved legally-marketed electrodes.
Hazardous voltages are exposed when the lid of the Protektor32 headbox is removed.
This system is NOT AP or APG rated. DANGER: Explosion hazard. Do not use in the
presence of flammable anesthetics.
Do not turn on the system until all cable connections have been made and their integrity
checked.
The proper use of this device for its intended purpose can only be assured once all
instructions have been read and understood. If there are any questions regarding the
operation of this device, please contact your Xltek representative at once.
The sale, distribution or use of this device is restricted to, by or on order of a licensed
medical practitioner.
The Protektor32 headbox is a Type BF device. According to the IEC 60601-1 standard, a
BF device is an applied part isolated from other parts of the equipment to such a degree
that no current greater than a set level flows if an unintended voltage is connected to the
patient. This set level of current is the maximum patient leakage current allowable in a
single fault condition. All of the patient connections of the Protektor32 headbox are
electrically isolated. However, these connections are not intended for direct cardiac
contact.
Electrical Shock Hazard. Do not connect electrode inputs to earth ground. The patient
headbox contains warning symbols to remind you that the connections are intended for
isolated patient connections only.
Remove all unused power cables from the vicinity of the Protektor32 system.
Connect all patient electrodes to fully electrically isolated physiological devices only.
Connection to any other device or external outlet may result in personal injury.
The Protektor32 headbox accepts only touch-proof style electrode inputs. Do not attempt
to use any other style of patient electrode input.
No equipment other than devices connected to the Protektor32 may be powered by an
isolation transformer. The current rating of the transformer must be sufficient to operate all
of the devices powered by it. Refer to the current ratings of each individual device.
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Possible interference with signals may occur in certain situations (for example, poor
grounding in circuitry and close proximity to other instrumentation such as an MRI).
The accessories of this device may include several kinds of disposable, sterile electrode
needles. These needles are labeled as STERILE and the method of sterilization is
documented on the packaging. These electrodes should not be used if the sterile
packaging has been tampered with.
The computer (desktop PC or laptop) connected to the Protektor32 headbox has a cooling
fan. Keep this area unobstructed to prevent overheating.
When the Protektor32 comes to the end of its operating life, it should be disposed of in
accordance with local waste disposal regulations.
Do not place more than 10lbs in the accessory bin on the Protektor32 Cart.

Multiple Portable Socket Outlets (MPSO) shall not be placed on the floor.

Additional MPSO or extension cord shall not be connected to the system.

Do NOT connect items which are not specified as part of the system.

Do NOT touch any Protektor32 accessible metal parts and the patient simultaneously.
Do NOT connect non-medical equipment, which has been supplied as a part of the system,
directly to the wall outlet when the system is supplied via MPSO with a separating
transformer.
Do NOT connect electrical equipment which, has not been supplied as a part of the
system, to the MPSO.
Connection of a patient to high-frequency surgical equipment (electrosurgical unit) and to
an electromyograph or evoked response equipment simultaneously may result in burns at
the site of the electrical stimulator or biopotential input part electrodes and possible
damage to the electrical stimulator or biological amplifiers. To minimize the potential for
such issues, read and follow the section of this manual labelled: “Guidelines for the use of
Protektor32 with Electro-Surgical Units.”
Corruption/loss of data over network due to unplugging the network cable or data
interruption during data transfer/hardware failure/ corrupt software.
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Do not install any other software than the EPWorks Software. Natus assumes no
responsibility when the equipment is not used as described in this manual.
Never touch the patient while connecting or disconnecting any connectors.
Portable RF communications equipment (including peripherals such as antenna cables and
external antennas) should be used no closer than 30 cm (12 inches) to any part of the
Protektor32 System, including cables specified by the manufacturer. Otherwise,
degradation of the performance of this equipment could result.

General Cautions
It is recommended that the stimulator probe be disinfected between patients with 70%
isopropyl alcohol. This is not a method of sterilization if the stimulator is used invasively.
Turn off all system power and disconnect the power cord from the system and the wall
before attempting to clean the unit. The Protektor32 headbox can be wiped clean with a
soft, damp cloth using non-conductive distilled water, electrically non-conductive inert
surfactants or an Xltek-approved cold sterilizing agent. It is important to dry off the units
quickly. Avoid letting liquid seep into any of the internal electronics of the system. Do not
use any abrasive cleaner on the system.
Inspect all cables and connections (especially the power cord) often for signs of fraying or
other damage. Do not operate the Protektor32 headbox if you suspect damage to any of the
cables or the power cord.
Do not leave any cables attached to the Protektor32 headbox when transporting the unit.
This may cause connections to become loose or malfunction during operation of the unit.
Do not turn on the power to the Protektor32 headbox immediately after bringing it in from a
cold environment to one at room temperature. Allow the unit to assume the ambient
environmental temperature (i.e. one hour warm up).
The isolated switch mode power supply is intended for connection only to a 110V, 120V,
220V or 240V external (wall) outlet.

Audio/Visual Stimulation Warnings
Only the Telephonics Model TDH-39P headphones and ear inserts (TIPS) provided have
been approved for use with your Protektor32. Patient isolation in accordance with
IEC60601-1 is dependent on the approved parts.
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Only equipment approved to IEC950, IEC 60601-1 or a similar safety standard may be
connected to the VGA port on the Protektor32. The final system must be configured to meet
the requirements for safety of medical systems prescribed by IEC60601-1-1.
Exposure to excessive sound can cause temporary and even permanent hearing loss.

Long-term exposure to excessive light can cause temporary and even permanent changes
in visual acuity.
Patient electrical isolation is ensured when all peripherals (headphones, printer, goggles,
monitor) attached to the Protektor32 are Xltek-approved. The final system configuration
must meet the requirements of IEC60601-1 for safety of medical systems.
If you choose to attach a VGA display other than the model supplied by Xltek, it MUST
either meet IEC60601-1 or the leakage current requirements for your jurisdiction.

Protektor32 with the Electro-Surgical Units (ESU) – Guidelines
Follow the safety guidelines below to ensure proper use of Protektor 32 with the Electro-Surgical Unit.
Failing to follow these guidelines may result in skin burns to the patient, and /or damage to the Protektor
32 unit.
1. When ESU is active, keep the ESU pencil away from the Acquisition box and stimulation
electrodes.
2. Use as large as possible patient ground electrode connected to the Protektor32 ground input.
3. Do not place Protektor32 ground electrode(s) in close proximity to the ground return electrode for
the ESU. Do not connect the ESU ground electrode to the Protektor32 ground.
4. Ensure that the dispersive pad for the ESU has a good electrical contact with the patient.
Although certain ESUs have a mechanism for checking the quality of contact, always visually
inspect the dispersive pad to ensure that it is properly applied.
Do not activate the electrosurgical unit for extended periods of time, unless the ESU
electrode is in direct contact with the patient.

Output Waveforms
The output waves from the Protektor32 are required to electrically stimulate the patient and evoke a
response. These waves have no D.C. component and are limited to ±400V and 100 mA on the standard
electrical stimulators, ±500V and 1500mA on the TCeMEP stimulator, and ±10V and 40mA on the
surgical probe stimulators. Since there is no D.C. component to the output, there are no specific
precautions which need to be taken with regard to a D.C. component.
If the load impedance exceeds the voltage limit for a given current, the stimulation output is attenuated in
proportion to the resistance. Typical loads would be in the range of 500 Ohms to 10 kOhms. The
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stimulation pulse duration ranges from 0.05 ms to 1.0 ms. Pulses are repetitive up to a maximum
frequency of 500 Hz.

Electrostatic Discharge (ESD) handling procedures and warnings
Before performing any setup or placement procedures, it is recommended that all clinical staff read and/or
are trained on the precautions outlined in this section.
WARNING: Be sure to take the appropriate Electrostatic Discharge (ESD) precautions.
Disconnect the cables before moving, cabling, or performing any set up procedures.
Some semiconductor (solid state) devices can be easily damaged by static electricity.
Such components are commonly called Electrostatically Sensitive Devices (ESD). Do not
touch the accessible conductive parts for the Connectors marked with the ESD symbol.
Follow these techniques to help reduce the incidence of component damage caused by
static electricity:
•

Immediately before handling any product components assemblies, drain the electrostatic charge from
your body by touching a known earth ground.

•

Minimize body motions when handling unpackaged replacement ESDs. Motions such as brushing
clothes together or lifting your foot from a carpeted floor can generate enough static electricity to
damage the product components.

•

Avoid carpets in cool, dry areas. If provided, leave the product components in their anti-static
packaging until ready to be installed.

•

Take care when connecting or disconnecting cables. When disconnecting a cable, always pull on the
cable connector or strain-relief loop, not on the cable itself.
WARNING: A damaged cable can cause a short in the electrical circuit. Prevent damage to
the connectors by aligning connector pins before you connect the cable.
WARNING: Misaligned connector pins can cause damage to system components at poweron.
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Protektor32 Safety and Standards Conformity
Essential Performance
The potential sources of unacceptable risk identified to characterize the ESSENTIAL PERFORMANCE of
EMG DIAGNOSTIC EQUIPMENT are:
•
•
•
•

Minimum noise on a waveform or artifacts or distortion in an image and any error of a displayed
numerical value which cannot be attributed to a physiological effect and which may alter the
diagnosis
Free from the display of incorrect safety-related indications
Free from the production of unintended or excessive stimulation output
Free from the production of unintended or excessive patient applied parts surface temperature

Standards Compliance and Normative References Information
Intraoperative Neuromonitoring device, Model Protektor32, transportable / mobile (when mounted on
cart), rated: 24Vdc, 2A. For use with external power supply (Jerome Industries; model WSL524MC; rated
100~240Vac, 50/60Hz, 140VA; Xltek P/N 005307)
1.
2.
3.
4.

Type of protection against electric shock: Class I
Degree of protection against electric shock: Type BF
Degree of protection against ingress of water: IPX0
Degree of safety of application in the presence of a flammable anaesthetic mixture with air or with
oxygen or nitrous oxide: Equipment not suitable for use in the presence of a flammable
anaesthetic mixture with air or with oxygen or nitrous oxide.
5. Mode of operation: Continuous
6. Environmental Conditions: Normal: 10-40°C, 30-75% rH, 700-1060hPa
The Protektor32 and its accessories have been designed to comply with the following national and
international standards.
Table 1 – Safety Standard of Compliance and Normative References
IEC 60601-1:2012 (Ed. 3.1)

Medical electrical equipment - Part 1: General requirements for
basic safety and essential performance Includes national
deviations as shown below.

ANSI / AAMI ES 60601-1:2005 +
A1:2012

Medical electrical equipment – Part 1: General requirements
for basic safety and essential performance

CSA C22.2 No. 60601-1:2014-03

Medical electrical equipment - Part 1: General requirements for
basic safety and essential performance

EN 60601-1:2006 + A1:2013

Medical electrical equipment – Part 1: General requirements
for basic safety and essential performance

IEC 60601-2-40:1998 (Ed. 1.0)

Medical electrical equipment - Part 2-40: Particular
requirements for the safety of electromyographs and evoked
response equipment

14

XLTEK Protektor32

Instructions for Use

IEC 60601-1-6: 2010 (Ed. 3.0) + A1:
2013

Medical electrical equipment - Part 1-6: General requirements
for basic safety and essential performance - Collateral
standard: Usability

IEC 62366:2007 (Ed. 1.0) + A1: 2014

Medical devices – Application of usability engineering to
medical devices
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Table 2 – EMC Standard of Compliance and Normative References
IEC 60601-1-2:2014 (Ed 4.0)

Medical electrical equipment – Part 1-2: General requirements
for basic safety and essential performance– collateral
standard: electromagnetic compatibility – requirements and
tests

IEC 60601-2-40:2016 (Ed. 2.0) –
Clauses 201.17 and 202

Medical electrical equipment - Part 2-40: Particular
requirements for the safety of electromyographs and evoked
response equipment

IEC 61000-4-2:2008 (Ed. 2.0)

Electromagnetic Compatibility (EMC) Part 4-2: Testing and
Measurement Techniques - Electrostatic Discharge Immunity
Test

IEC 61000-4-3:2010 (Ed. 3.2)

Electromagnetic Compatibility (EMC) Part 4-3: Testing and
Measurement Techniques - Radiated, Radio-frequency,
Electromagnetic Field Immunity Test

IEC 61000-4-4:2012 (Ed. 3.0)

Electromagnetic Compatibility (EMC) Part 4-4: Testing and
Measurement Techniques - Electrical Fast Transient/Burst
Immunity Test

IEC 61000-4-5:2005 (Ed 2.0)

Electromagnetic Compatibility (EMC) Part 4-5: Testing and
Measurement Techniques - Surge Immunity Test

IEC 61000-4-6:2013 (Ed. 4.0)

Electromagnetic Compatibility (EMC) Part 4-6: Testing and
Measurement Techniques - Immunity to Conducted
Disturbances, Induced by Radio-frequency Fields

IEC 61000-4-8:2009 (Ed. 2.0)

Electromagnetic Compatibility (EMC) Part 4-8: Testing and
Measurement Techniques - Power Frequency Magnetic Field
Immunity Test

IEC 61000-4-11:2017 (Ed. 2.1)

Electromagnetic Compatibility (EMC) Part 4-11: Testing and
Measurement Techniques - Voltage Dips, Short Interruptions
and Voltage Variations Immunity Tests

IEC 61000-3-2:2018 (Ed. 5.0)

Electromagnetic Compatibility (EMC) Part 3-2: Limits - Limits for
Harmonic Current Emissions

IEC 61000-3-3:2013 (Ed. 3.0)

Electromagnetic Compatibility (EMC) Part 3-3: Limits Limitation of Voltage Changes, Voltage Fluctuations and Flicker
in Public Low-voltage Supply Systems

CISPR 11:2010 (Ed. 5.0) + A1

Industrial, Scientific and Medical (ISM) Radio-Frequency
Equipment - Electromagnetic Disturbance Characteristics Limits and Methods of Measurement
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Declaration of Compliance for IEC 60601-1-2
Table 3 - Electromagnetic Emissions
Guidance and Manufacturer’s Declaration – Electromagnetic Emissions
The Protektor32 is intended for use in the electromagnetic environment specified below. The customer
or the user of the Protektor32 should assure that it is used in such an environment.
Emissions test

Compliance

Electromagnetic environment - guidance

RF emissions
CISPR 11

Group 1

The Protektor32 uses RF energy only for its internal function.
Therefore, its RF emissions are very low and not likely to cause
any interference in nearby electronic equipment

RF emissions
CISPR 11

Class A

Harmonic
emissions IEC
61000-3-2

Class A

The Protektor32 is suitable for use in all establishments other than
domestic and those directly connected to the public low-voltage
power supply network that supplies buildings used for domestic
purposes.

Voltage
fluctuations/
flicker emissions

Complies

IEC 61000-3-3

Warning: This equipment/system is intended for use by healthcare
professionals only. This equipment/system may cause radio
interference or may disrupt the operation of nearby equipment. It
may be necessary to take mitigation measures, such as reorienting or relocating the Protektor32 or shielding the location.

Table 4 - Immunity Test Levels - Enclosure Port
Phenomenon

Electrostatic Discharge

Basic EMC
Standard or Test
Method
IEC 61000-4-2

Immunity Test Levels – Professional
Healthcare Facility Environment
± 8 kV contact
± 2 kV, ± 4 kV, ± 8 kV, ± 15 kV air

Radiated RF EM Fields

IEC 61000-4-3

3 V/m
80 MHz – 2,7 GHz
80 % AM at 1 kHz

Proximity Fields from RF
Wireless Communications
Equipment

IEC 61000-4-3

See “Enclosure Port Immunity to RF
Wireless Communications Equipment”
Table below

Rated Power Frequency
Magnetic Fields

IEC 61000-4-8

30 A/m
50 Hz or 60 Hz

Table 5 – Immunity Test Levels – Input A.C. Power Port
Phenomenon

Basic EMC
Standard

Immunity Test Levels – Professional
Healthcare Facility Environment
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Electrical Fast Transients /
Bursts

IEC 61000-4-4

Surges

IEC 61000-4-5

± 0,5 kV, ± 1 kV

IEC 61000-4-5

± 0,5 kV, ± 1 kV, ± 2 kV

IEC 61000-4-6

3V

± 2 kV
100 kHz repetition frequency

Line-to-line (Differential Mode)
Surges
Line-to-ground (Common Mode)
Conducted Disturbances
Induced by RF Fields

0,15 MHz – 80 MHz
6 V in ISM bands between
0,15 MHz and 80 MHz
80 % AM at 1 kHz

Voltage Dips

IEC 61000-4-11

100% dip; 0,5 cycle
At 0°, 45°, 90°, 135°, 180°, 225°, 270° and
315°
100% dip; 1 cycle
and
30% dip; 25 cycles (50Hz)
Single phase: at 0°

Voltage Interruptions

IEC 61000-4-11

100% dip; 250 cycles (50Hz) /300 cycles (60
Hz)

Table 7 – Patient Coupling Port
Phenomenon
Electrostatic Discharge

Basic EMC Standard
or Test Method

Immunity Test Levels – Professional
Healthcare Facility Environment

IEC 61000-4-2

± 8 kV contact
± 2 kV, ± 4 kV, ± 8 kV, ± 15 kV air
3V

Conducted Disturbances
Induced by RF Fields

0,15 MHz – 80 MHz
IEC 61000-4-6

6 V in ISM bands between
0,15 MHz and 80 MHz
80 % AM at 1 kHz

Table 8 – Immunity Test Levels - Signal Input / Output Parts Port
Phenomenon
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Basic EMC
Standard

Electrostatic Discharge

IEC 61000-4-2

Electrical Fast Transients/Bursts

IEC 61000-4-4

Immunity Test Levels – Professional
Healthcare Facility Environment
± 8 kV contact
± 2 kV, ± 4 kV, ± 8 kV, ± 15 kV air
± 1 kV
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Basic EMC
Standard

Phenomenon

Immunity Test Levels – Professional
Healthcare Facility Environment
100 kHz repetition frequency
3V

Conducted Disturbances Induced
by RF Fields

0,15 MHz – 80 MHz
IEC 61000-4-6

6 V in ISM bands between
0,15 MHz and 80 MHz
80 % AM at 1 kHz

Table 9 - Test specifications for ENCLOSURE PORT IMMUNITY to RF wireless
communications equipment
Test
frequency
(MHz)
385

Band
(MHz)

Service

Modulation

Maximum

Distance

IMMUNITY

Power

(m)

TEST
LEVEL

(W)
380 –390

TETRA 400

Pulse

(V/m)

1,8

0,3

27

2

0,3

28

0,2

0,3

9

2

0,3

28

modulation
18 Hz
450

430 – 470

GMRS 460,
FRS 460

FM
± 5 kHz
deviation
1 kHz sine

710

704 – 787

LTE Band 13, 17

745

217 Hz

780
810

Pulse
modulation

800 – 960

GSM 800/900, TETRA
800, iDEN 820, CDMA
850,LTE Band 5

Pulse
modulation

1,700 –
1,990

GSM 1800; CDMA
1900; GSM 1900;
DECT; LTE Band 1, 3,
4, 25; UMTS

Pulse
modulation
217 Hz

2

0,3

28

2,400 –
2,570

Bluetooth, WLAN,
802.11 b/g/n, RFID
2450, LTE Band 7

Pulse
modulation
217 Hz

2

0,3

28

870

18 Hz

930
1,720
1,845
1,970
2,450
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5,240
5,500

5,100 –
5,800

XLTEK Protektor32
WLAN 802.11 a/n

Pulse
modulation

0,2

0,3

9

217 Hz

5,785

Declaration of Compliance for FCC
Note:

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own expense.

Warning:

Changes or modifications not expressly approved by the manufacturer could void the
user's authority to operate the equipment.
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Regulatory Symbols
A number of symbols appear on the various components of the Protektor32 system. Please consult the
table below for their meanings and significance.
Symbol

Description
ATTENTION:
Consult Accompanying Documents

Consult Accompanying Documents

Consult Operating Instructions

Protective Earth (Ground)

Type BF Equipment

Dangerous Voltage

Alternating Current

Direct Current

Electrostatically Sensitive Device (ESD)
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Description

Power On

Power Off

CE Mark

Canadian Standards Association
(indicates safety approval by)

TUV Safety Tested and Production Monitored

Made in Canada

EU only: Do Not Dispose as Unsorted Municipal Waste
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Protektor32 System Configuration

Device styles/models may vary from those shown above.
Legend
A
B
C
D
E
F
G
H
I
J
K
L

Description

Legend

Stimulator Pods
Low Current Stimulator Pods
TCeMEP Pod
Acquisition Pods
Oximeter
Goggles
Cautery Detector
Headphones or Ear Inserts
VGA Monitor**
Power Cable (MAINS)
Isolation Transformer
Printer**

Description

M
N
O
P
Q
R

Medical Grade Power Supply
Isolation Box
PC/Laptop
External Triggers
Acquisition Head Box
Stimulator Head Box

1
2
3
4
5

Communication Cable
VGA Cable
DC Power Cable
Power Cable
USB Data Cable

**VGA monitor and Printer are optional.
Applied Parts include electrodes for EEG and EMG data acquisition, goggles for visual stimulation,
headphones for auditory stimulation, electrical stimulators, and pulse oximeter.
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Note: Use only Xltek approved cables and accessories with this device.

Protektor Headbox
The Protektor32 headbox contains a complete data acquisition system that has built-in amplifiers, A/D
Converters, Digital Signal Processors, CPUs, and storage devices.

Protektor32 Headbox Features
•

Up to 32 Analog Input Channels (differential or referential).

•

2 Independent Electrical Stimulators, --each with eight switchable output ports, and 2 low-current
probe ports.

•

1 Auditory Stimulator.

•

1 Visual stimulator.

•

2 Bi-directional external triggers

•

Full Bandwidth Acquisition (60 kHz sampling).

•

Simultaneous Multi-Channel EP, EMG, and EEG.

•

Ultra-Low-Noise Amplifiers

•

Connects to Laptop or Desktop

•

Small and light enough to be carried into the OR

•

Switch Matrix

•

Stim Pods

•

Breakout Box

The Protektor32 headbox can be connected to other equipment through a communications port; two
external trigger input/outputs; and a cautery detection port.

24

XLTEK Protektor32

Instructions for Use

Connecting Protektor Headbox
The instructions which follow demonstrate how to connect the Protektor32 headbox to a laptop or desktop
computer.
Position the equipment so that the detachable mains cord is readily accessible for
disconnection.
1. Plug the power cord into the Isolation Box.

Figure 1: Power Connected to Headbox Power Connection
2. Connect the Isolation–Acquisition cable into the Isolation box and to the Acquisition box.

Figure 2: Isolation-Acquisition cable connected to Isolation Box
3. Connect the Acquisition box to the Stimulator box using the Acquisition – Simulator cable:
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Figure 3: Connecting the Acquisition box to the Stimulator box

4. Connect the USB cable between the Isolation box and the Laptop / Desktop PC.

Figure 4: Connecting the Isolation box to the Laptop
5. Connect the Acquisition / Stimulator pods to the acquisition and stimulator boxes.

Figure 5: Connecting a stimulator pod to the stimulator box.
Examples of detachable pods

Detachable Stimulating Pod

Acquisition Pod

Example of Pod holder with cable clip
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Using the TcMEP Stimulator with Protektor32
The TcMEP stimulator with Protektor 32 provides a mode of operation that delivers single or train stimuli
at a rate up to a few pulses per second.

Safety Information
Contra-Indications and Exclusions
Contra-indications and exclusion criteria for Protektor32 Transcranial Stimulation mode:
•

Subjects with a history of head injury, stroke, epilepsy, seizures or other neurological impairment.

•

Subjects with a history of cerebral aneurysm.

•

Subjects with any type of implanted biomedical device (for example, a pacemaker).

•

Subjects with metal plates or fragments in their head.

Protocol for Elicitation of TcMEPs
Place the stimulating electrodes on the patient’s scalp according to your laboratory protocols for
stimulating electrode locations. Several different configurations of stimulating electrodes have been
reported, including stimulation between C3 and C4 [Calancie et al. 1998, 2001; Jones et al. 1996] using
the International 10-20 standards for EEG electrode placement. Next, place recording electrodes
according to the location(s) from which you wish to record.
The ultimate decision of how to use the TcMEP modes (including stimulating electrode placement,
recording electrode placement, and type of electrodes) is up to the user. We refer the user to published,
peer reviewed papers where detailed descriptions of different protocols to perform TcMEP are available.
NOTE: In order to avoid false positive warnings to the surgical team, it is imperative that
there is a thorough understanding that substantive alterations in anesthesia delivery, or
mean arterial blood pressure, can account for deviations from TcMEP intra-operative
baselines.
References:
1) Calancie B., Harris W, Brindle GF, et al: Threshold-level repetitive transcranial electrical
stimulation for intra-operative monitoring of central motor conduction. J. Neurosurg Spine 95:
161-168, 2001.
2) Calancie B., Harris W, Broton JG, Alexeeva N, Green BA: “Threshold-level” multipulse
transcranial electrical stimulation of motor cortex for intra-operative monitoring of spinal motor
tracts: description of method and comparison to somatosensory evoked potential monitoring. J.
Neurosurg 88: 457-470, 1998.
3) Jones SJ, Harrison R, Koh KF, Mendoza N, Crockard HA: Motor evoked potential monitoring
during spinal surgery: responses of distal limb muscles to transcranial cortical stimulation with
pulse trains. Electroencephalogr Clin Neurophysiol 100: 375-383, 1996.
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TcMEP Warnings and Cautions
Stimulating electrodes must be large enough so that the current density is always less
than 2 mA r.m.s./cm2. Current densities exceeding 2 mA r.m.s./cm2 may require special
attention of the operator. For example, if the stimulus is stimulating at 100 mA at 10 Hz,
with a duration of 1 ms, then the stimulus electrode must be at least 0.5 cm2.
When an electrode with a small surface area is used (such as a needle electrode), the
current density rises.
Current density in TcMEP mode is dependent on the stimulation strength (voltage) and
number of pulses. If the stimulation parameters are different from those detailed in the
table and the voltage is greater than these thresholds, it may cause skin burns.
For a detailed description and calculations of the stimulation parameters needed to
achieve less than 2 mA rms / cm2 refer to the Table 4 appearing below.
Patient movement may occur during stimulation, leading to inadvertent neural injury. Take
adequate steps to avoid stimulation when patient movement could cause injury.
Due to the high current density and risk of patient burns, corkscrew and needle electrodes
with low surface areas, such as those 13 mm long and 0.4 mm in diameter should not be
used for stimulation with the TcMEP stimulator.
Cortical stimulation may not be appropriate for use on patients with a history of skull
fracture or neurosurgical procedures to the head. Skull defects could provide high local
current densities.
Cortical stimulation may induce seizures and memory problems in those with a history of
epilepsy and other disorders with predisposition to seizures (e.g. alcoholism). Ensure that
necessary medical precautions are taken in case of such an episode.
Otherwise unexplained intra-operative seizures and possible arrhythmias are indications
of cease use of the TcMEP stimulator.
The TcMEP stimulator outputs must be connected to the stimulating electrodes only.
Unintentional misconnection of the outputs to ground electrodes could result in current
being dangerously applied to organs other than the cerebral cortex.
Studies by Calancie et al. relied upon to demonstrate safety and effectiveness of the
device employed threshold level monitoring to increase patient safety by minimizing
energy delivered.
When using the electrical stimulator many times over a long period, check the moisture
and the paste on the stimulation electrodes periodically. When electrical stimulation is
conducted over an extended period of time, the moisture and the paste on the stimulation
electrodes dry out; as a result, if the electrical stimulation continues with it dried out, the
point that is being stimulated with high current density will get hot and may cause a burn.
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When both a high-frequency surgical instrument and the electric stimulator are used for
the patient at the same time, there is a possibility that burns will result where the electrode
is applied or damage to the electrode used. Remove the electrode when you use a highfrequency surgical instrument.
The output of the electric stimulation parts might be unstable when a shortwave or
microwave therapeutic instrument is close to the electrode. Turn off the power of the
electrical stimulator when using a microwave therapeutic instrument.

Stimulation limitations of the TcMEP modality
1. Energy limitation per pulse
50mJ per pulse on a 1000 Ohm Load (Safety requirement according to IEC60601-2-40 –
collateral standard)
2. Energy limitation per time period
Maximum = 100mJ per second distributed in maximum 9 pulses on a 1000 Ohm load.

Pulse Train Safety Limits
To prevent excessive delivery of stimulation to the patient, Protektor32 is set-up with specific conditions
for the relationship between the output voltage and number of pulses of stimulation. The Total energy
delivered to the patient by the Protektor32 TcMEP stimulator depends on the number of pulses per train
and the selected stimulation voltage.
The calculated energy the device will deliver to the patient is depicted in the following figure:

Energy Limitation vs. Allowable Settings
Settings outside the ranges depicted in the figure are not allowed by the device. If the set value is
exceeded, the Protektor32 function for limiting output is triggered.

30

XLTEK Protektor32

Instructions for Use

Current Density
When using TcMEP mode you must be aware of the Current density. Current density is dependent on
the stimulation strength (voltage) and number of pulses. In order to achieve current densities less than 2
mA rms / cm2 you can use the parameter settings-setup appearing in Table 4.
Table 4: Maximum voltage - number of pulses combinations to achieve less than 2 mA rms/cm2.
Maximum voltage settings per pulse setting per electrode configuration to avoid current densities above
2mARMS/cm2
Pulses per second

1

2

3

4

5

6

7

8

9

180

147

127

114

104

96

90

85

One EEG disc electrode (0.9cm2)
Voltage Settings [V]

255

DISPOSABLE SILVER EEG DISC ELECTRODES - Diameter of cup: 10 mm; Height of cup: 3 mm;
Surface area = 90 mm2 (Part #105191 in the Natus Neurodiagnostic Accessories Catalogue)
If you use settings-setups combinations exciding those detailed in Table 4 above, stimulation
may result in skin burns and will require special attention of the operator.

Priming Pulses

1

Test Pulses

num priming
pulses

2

1

...

t

num test
pulses

2

...

Priming Gap
i

i

t = Pulse Duration – Fixed at 50us
i = Interpulse Interval (pulse rate)
Note: Num Priming Pulses + Num Test Pulses cannot exceed 9 total.
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Train of pulses

1

Next Train of pulses
total num
pulses

2

1

...

...

Min Repetition Time
(1 second)

32

total num
pulses

2
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Recommended User Performed Maintenance
Routine System Maintenance
In a solid state system, with no moving parts, there is no need for routine maintenance. However, if you
still wish to test the system, input a 1 mV, 1 Hz square wave using a calibrated signal generator. The
waveform displayed on screen should appear as a square wave with appropriate amplitude and
frequency. It is important to note that the current filter settings may distort the waveform.

General User Performed Maintenance
To keep the Protektor32 system in good working condition, follow a regular schedule of preventive
maintenance. Regular user performed maintenance does not involve access to the interior of the
Protektor32 headbox and components. For service problems that require corrective maintenance and/or
internal component service, call Xltek Technical Support at 1-800-303-0306, or contact your local Xltek
representative.
Periodically check cable connections and electrodes for damage and wear. Inspect cables for bent pins.
Replace frayed or worn cables. Also, regularly inspect and clean all system components, including:
•

Connectors and jack ports

•

Electrodes and accessories

•

Stimulator / Acquisition / Isolation Boxes and cables
NOTE: Taking basic care of the system and avoiding extreme physical abuse helps
prolong the lifespan of system components.

Maintenance Warnings
Do not service or maintain this equipment while in use with the patient.

Disconnect the Protektor32 headbox and breakout box from the computer before wiping.
Disconnect all cables. Use a lint-free cloth. Do NOT use cleaners on any system
component.
Be careful not to allow any fluid to seep into the internal electronic components of the
headbox or breakout box.
Do NOT leave the headbox or breakout box attached to the computer when transporting
the unit.
Do NOT use petroleum-based or acetone solutions, or other harsh solvents, to clean the
device.
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Environmental Conditions
Operating Environmental
Limits

Temperature: 10° to 40°C
Relative Humidity: 30%–75%
Altitude: Up to 4600 meters above sea level
Atmospheric Pressure: 500 hPa to 1060 hPa

Transport and Storage Limits

Temperature Range: -40°C to 70°C
Humidity Range: 10%–100%, including condensation
Atmospheric Pressure Range: 500 hPa to 1,060 hPa

Electrical Ratings of Isolation
Box, Acquisition Box, and
Stimulator Box with
Protektor32 Cart

24Vdc/ 2A

Isolation Transformer
Maximum Output Power

P/N 006979: 100VAC-50/60Hz, 8.7/4.35A (850VA),
115(120)/230(240)VAC-50/60Hz, 8.7/4.35A (1000VA)
P/N 010758: 120VAC-60Hz, 7.50A (900VA)

Waste Management
Waste Electrical and Electronic Equipment Compliance.
Do not dispose of this product in the unsorted municipal waste stream. Dispose of the
product according to the local regulations.
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Protektor32 Software / EPWorks
Setting Up Tests
A) Before You Begin
1.
2.
3.
4.

Ensure that the headbox is connected to the computer and turned on.
Open EPWorks by double-clicking the EPWorks icon on the Windows® desktop.
Click File > New. The Study Information window will appear.
Type the patient's first and last name into the designated text boxes. (You can fill in more
information now, or you can reopen the Study Information window to fill in more information later

by clicking
on the EPWorks toolbar.)
5. Click OK. The Test Directory window will open. (See illustration below).

Test Directory Window. The tests appearing on this image are for illustration purpose only.
The Study Information button on the EPWorks toolbar opens the Study Information
window so you can add or edit information.
The Settings button on the EPWorks toolbar opens the Edit Test window so you can input
or change the test settings or switch to a new test.

Create a Basic Test
1. From Test Directory, open the Edit Test window by clicking the Create… button.
2. Click the New… button and select the number of channels that the test requires.
•
•
•

EP-8: Runs on the EP-8 and EP-16 headboxes;
EP-16: Runs only on the EP-16 headbox;
Protektor: Runs only on the Protektor headbox.

3. To set up electrode locations, click an electrode Location cell. Type in a name to label the
location --e.g., “C-3” in the E3 electrode location cell, or “C-4” in the E4 electrode location cell-and press the Enter key. The location label is automatically placed on the headbox input map.
4. Enter a name for the test, e.g., Master Electrode, in the Test Definition text box. Note that tests
are grouped in alphabetical order.
5. Click Save, to save the test with the new name.
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B) Edit Text Window Tabs – Configuring a Basic Test
The following tests can be configured from the Edit Test window tabs:
•

Electrodes

•

Groups

•

EEG Montage

•

Traces

•

Channels (Amplifier Inputs)

•

Markers

•

Electric Stimulators

•

Layouts

•

AV/External Stimulators

•

Reporting

•

Timelines

Test Directory – New Test

New Test…
Acoustic Nerve
Bilateral SSEP Lower Interleaved
Bilateral SSEP Upper Interleaved
Clinical Auditory EP
Clinical Visual EP
Four Channel Mapping
Four Extremity Interleaved SSEP
Hardware Channel Test
Hardware Electrical Stim
L3-4 L5-S1 Free Run
L3-4 Free Run
L3-4 Triggered
L5-S1 Free Run

--Test Directory – New Test
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C) Electrodes Tab
To make any required modifications to the electrode locations:
1. Click the Electrodes tab;
2. Enter your changes (e.g., add muscles or special electrodes)
3. Click Save.
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D) EEG Tab
The EEG tab allows you to set up channels and filters for an EEG montage. Standard 10-20 locations
defined in the Electrodes settings are automatically placed on the EEG tab head map.

To use the head map to set up a Differential Channel:
1. On the EEG tab head map, locate the pointer over the desired Input 1 location. Pressing the left
mouse button, move the pointer to the desired Input 2
location and release. A red arrow is drawn between the
locations. A new channel is added to the EEG table listing
Input 1, Input 2 and default settings for the new channel.
2. Repeat Step 1 until you have added the required channels to
the test.
3. To select the remaining settings for the new channel, rightclick column headings or individual cells and select values for
LFF, HFF, Notch, Color, Gain, and Quadrant from the popup menus.
4. Click OK to save.
To use the EEG table to set up a Differential Channel:
1. Click the Add button. An empty channel with a red background will appear in the table.
2. Right-click the Input 1 cell of the new channel and select an EEG electrode location from the
pop-up menu.
3. Right-click the Input 2 cell of the new channel and select an EEG electrode location from the
pop-up menu.
4. Repeat Steps 1 to 3 until you have added the required channels to the test.
5. Select the remaining settings for the new channel by right-clicking column headings or individual
cells and select values for LFF, HFF, Notch, Color, Gain, and Quadrant from the pop-up
menus.
6. Enter a name for the montage in the Name text box above the head map.
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7. Click OK to save.
To use the head map to set up Referential Channels:
1. Click a location on the headmap to select Input 1. A new channel will appear in the EEG table
with Input 1 set accordingly.
2. Repeat Step 1 until you have added the channels you require to the test.
3. To select the remaining settings for the new channels, right-click column headings or individual
cells to select values for LFF, HFF, Notch, Color, Gain, and Quadrant from the pop-up menus.
See the topic EEG Channel Settings for more information.
4. Click OK to save.
Note that if a referential channel already exists, it will not be added to the table when you
click that location in the head map.
To use the EEG table to set up referential channels:
1. Click the Add button that is located to the right of the EEG table. An empty channel with a red
background will appear in the table.
2. Right-click the Input 1 cell of the new channel and select an EEG electrode location from the
pop-up menu.
3. Repeat Step 1 until you have added the required channels to the test.
4. To select the remaining settings for the new channels, right-click column headings or individual
cells to select values for LFF, HFF, Notch, Color, Gain, and Quadrant from the pop-up menus.
See the topic EEG Channel Settings for more information.
5. Click OK to save.

Setting Up Channels for Custom EEG Locations
Before you set up a channel for a custom EEG electrode location, you need to assign a custom EEG
location in the Electrodes tab. Once this is done, the custom location appears in the pop-up menu when
you right-click an Input 1 cell in the EEG tab.
To set up a channel for your custom EEG electrode location:
1. Click the button to add a new channel to the montage.
2. Right-click the Input 1 column cell and select the custom EEG location you want from the pop-up
menu.
3. Repeat Step 1 to add the required custom channels to the test.
4. To select the remaining settings for the new channels, right-click column headings or individual
cells to select values for LFF, HFF, Notch, Color, Gain, and Quadrant from the pop-up menus.
See the topic EEG Channel Settings for more information.
5. Enter a name for the montage in the Name text box above the head map.
6. Click OK to save.
Custom EEG locations can also be used to set up the EEG montage; however, note that
they will not appear on the EEG tab head map.
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E) Channels Tab

To specify the electrodes you will be using in each channel:
1. Click the Channels tab. --Each pair of electrodes that is added here will use one of the available
channels on the headbox. -- Click Append to add a new channel to the Inputs table.
2. To choose an active electrode for the channel, right-click the cell in the Active column, and select
an active electrode from the menu displayed.
3. To choose a reference electrode for the channel, right-click the cell in the Reference column and
select an electrode location from the menu. Repeat Steps 3 and 4 until you have all of the
required inputs for your montage.
To invert waveforms – e.g., Left Erbs point to Right Erb’s point, and then Right Erb’s point to
Left Erb’s point -- so that they will deflect upwards on the active window. To do so, you must
add another input channel.
4. The amplifier gain is set in the Input Range column of the Inputs tab. To set the same input
range for all of the input channels, right-click the Input Range column heading and select a value.
To set different gains for different channel types, right-click a cell in the Input Range column and
select a value.
For most EP recordings, an amplifier gain of ±50 - ±100 µV is generally acceptable.
If too much noise is present, however, an amplifier input range of ±500 µV is advisable for
EMG recordings.
5. Reject Threshold is the level at which the input (amplifier) rejects unwanted signals (e.g., from
Bovie knife and bipolar cauterizers). To set the Reject Threshold, right-click the column heading
or individual cells and select a value from the menu. Note that you may select a level below the
Input Range, but not above. To adjust your Reject Threshold up, you must increase your Input
Range.
6. To enable your speaker for EMG sound, right-click cells in the Sound column and select Off, 25,
50, 75 or 100% as desired.
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7. To set the auto squelch or speaker so as not to respond below a certain level, and avoid 60 Hz
hum, right-click the cells in the Squelch column and set a squelch threshold.
8. Click Save.

F) Electric Stimulators Tab

To set up the Electric Stimulators:
1. Click the Electric Stimulators tab.
2. To add the stimulators you want, click the Add button and select stimulator from the drop-down
menu. Repeat until you have added all the stimulators that are needed for the test.
3. Click each cell in the Name column and type a name for each stimulator (e.g., “Left PTN” or
“Right PTN”).
4. To select a mode of stimulation, right-click the cells in the Mode column and select from single
pulse, repetitive pulse, triggered, free run and averaged. Note that the selected mode determines
which options are available in the remaining columns.
5. To set the maximum intensity of the stimulator output, right-click the cells in the Maximum
Intensity column and select from the available intensities (Maximum available intensity 100 mA
(milliamps)).
6. To set the duration of the stimulation, right-click the cells in the Pulse Duration column and
select from 0.05 ms, 0.1 ms, 0.2 ms, 0.3 ms, 0.5 ms, 1 ms.
7. To set the stimulus rate, right-click the cells in the Pulse Rate column, and select the desired
rate.
8. The remaining columns allow you to set Pulse/Train and Train Rate.
9. Click Save.
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G) AV/Ext Stimulators Tab
The AV/Ext Stimulators tab is used to set stimulation parameters for the internal
Auditory/Visual stimulators and /or the external Trigger In/Out ports.

1. Use the Stimulator pull-down menu to select the type of stimulator hardware that will be used for
the test. You can select either Headphones or TIPs (ear inserts).
If you select tips for recording a 0.9ms stim delay will be removed from the waveform
latency
2. In the Auditory section, select the type of Ipsilateral Sound that will be used for the test: Click,
Pip or Tone. Depending on which option you select, you will need to refine your selection further.
These are your options:
Click

•
•
•
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Alternating: Select to make the click sound alternate between the
rarefaction and condensation waveform type. This default setting is used
most commonly during auditory stimulation.
Rarefaction: Select to use a waveform that is in inverse proportion to
the condensation waveform type.
Condensation: Select to use a waveform that is in inverse proportion to
the rarefaction waveform type.

Pip

If Pip is selected, then you must type a value into the Rise/Fall Time [ms]
text box.

Tone

If Tone is selected, then you must type a value into the Duration [ms] text
box.
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3. Select a Contralateral Sound. This setting allows you to select which type of stimulation to use
in the ear that is opposite to the ear that is being monitored.

•
•
•

Masking Tone: A contralateral sound used for auditory stimulation raises the threshold of
audibility for the ipsilateral sound by the presence of another (masking) sound.
Noise: The contralateral sound used for the test lowers the threshold of audibility for the
ipsilateral sound by the presence of another random, discordant sound.
Silence: No contralateral sound is used for the test if Silence is selected.

4. In the Visual section, set the stimulator unit for Pattern Reversal or Goggles.
•
•
•
•
•
•

Stimulator: Use the Stimulator pull-down menu to select the type of stimulator hardware that
will be used for the test. You can choose either Goggles or Monitor. All of the settings below
are for Monitor only.
Modality: The Modality pull-down menu allows you to select the visual pattern that will be
used for the visual stimulation. You can choose from Stripes or Quadrants (a checker-board
pattern).
Color: You can specify the color of the stimulation pattern. Choose from Black, Red, Blue or
Green. This feature is only available when Monitor is selected as the visual stimulator.
Acquire On: Use the Acquire On pull-down menu to specify which colors will trigger the
acquisition of EP data: Both, White or Color. This feature is only available when Monitor is
selected as the visual stimulator.
Rate [Hz]: Type a value into the Rate [Hz] text box to set the rate of the visual stimulation in
Hertz.
Flash: Select this box to display a gray pattern in between two quadrant/stripe patterns on
the monitor.

5. Click Save.

H) Timelines Tab
Timelines are used to tell EPWorks when to start gathering a new set of waveforms. You can set your
timeline to be Interleaved or Consecutive. You can further modify the timeline to run continuously; to run
once and never restart; or to run on intervals. A timeline is mainly used for interleaving stimuli when using
two or four-limb stimulation.
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To set up one or more timelines:
1. Click the Timelines tab.
2. To add a new timeline row to the timelines table, click Append.
3. To select the type of timeline, right-click the cell in the Type column and select Interleaved or
Consecutive. Interleaving causes back and forth stimulation that alternates from one side to the
other.
4. In the Restart column, set the restart property for each cell to Never, Continuous or On
Interval….
5. Click Save.

I) Groups Tab
The Groups tab is used to set up collections of traces. Each group may consist of traces that are
associated with a given stimulus (e.g. L(eft) Lower SSEP, R(igth) Lower SSEP). Each group can be
viewed in a separate window during acquisition or review.
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To set up groups for the test:
1. Click Append, to add a row for a new group.
2. Enter a name for the group in the Name column.
3. To select a signal type for the group, right-click the cell in the Signal Type column and select
Free Run, Triggered or Averaged.
4. If you select the Triggered or Averaged signal type then right-click the cell in the Trigger (Stim)
column to select from a menu of the stimulators you set earlier.
5. Use the Stim Delay column to set the stimulation delay for Groups set up with Interleaved
timelines.
6. The Stim Delay button in the bottom right corner of the Groups tab is used to automatically
calculate the Stim Delay settings. The Stim Delay button does not work until after the Traces tab
has been set up.
7. Sweeps/Averages is the number of sweeps that are included in the whole average. Right-click the
cells in the Sweeps/Averages column to enter your preferred setting.
8. To set a timeline for a group, right-click the cell in the Timeline column and select a timeline from
the menu of timelines that you setup earlier in the Timelines tab.
9. The Capture column is used to set the threshold for capturing epochs of Free Run data. Rightclick a cell in the Capture column to select from the following options:
•
•
•

Start Capturing/Recording: Use this setting to turn Capture on and off. You can also rightclick a particular waveform in a Waveform window to turn Capture on and off. When Capture
is turned on, there is a checkmark beside the capture value.
Threshold: is the user-defined voltage value at which, if any data point exceeds this (and
does not exceed the “rejection threshold”) the data is “Captured” and displayed. Select to
enter the capture threshold in µV.
Chime: is a user defined sound that will be played whenever a waveform is “Captured”.
Select a sound from the Chime menu to set a sound to play every time the waveform data
meets the Threshold.
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10. The Trig. Delay column (for triggered stimulation) sets the delay in milliseconds from the time the
simulation starts to the start of the acquisition. You can set the trigger delay to both positive and
negative values.
11. To set the display mode, right-click a cell in the Disp. Mode column and select one of the these
options:
•
•
•

Replace: Displays the number of sets of traces that are set in the Replace Mode option.
Vertical Curve Stack: A maximum of 50 traces are displayed consecutively in and spaced
apart vertically.
Overlay: Sets of traces are superimposed (displayed with coincident origins) in the waveform
window. The number of overlaid traces is set in the Overlay Mode option.

12. To set the number of traces displayed in Replace Mode or Overlay Mode:
•
•

For an individual waveform window, right-click the background of the waveform window and
click the Layout tab.
For all waveform windows, select Customize from the Tools menu and click the Traces tab.

13. To set the display stack type, right-click the cell in the Disp. Stack column and select one of the
following options:
•
•

Trace Stack: Organizes the traces within the group according to the channels that are part
of each group.
Set Stack: Places traces together that are acquired at the same time.

14. In the Nb. Div. column, set the maximum number of divisions of the waveform window grid to 10,
20 or 30.
15. Click Save.

J) Traces Tab
A trace is a collection of waveforms that is acquired through the same input channels. You can define up
to 32 traces for one test. The Traces tab allows you to define the attributes for each trace.
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To set up traces to appear in the groups:
1. Click Append and then select a group from the menu of groups to add a trace to the test. A new
row is added to the Traces table.
2. To give the trace a custom name, click inside the Name column cell and type in a name. If you do
not type in a custom name, then EPWorks automatically names the trace after the input when you
select an input.
3. To define which inputs will create the trace, right-click the cell in the Input column and select an
input from the menu. (Inputs are predefined in the Inputs tab.)
4. The cell in the Group column was set when you selected a group from the Append button menu.
(If desired, you can change the group by right-clicking the Group column cell.)
5. To set the low frequency filter to filter out interference below a certain value, right-click the cell in
the LFF column and select a setting from the menu. The range of values for LFF is 0.1 Hz to 200
kHz.
6. The high frequency filter sets a circuit to pass all frequencies above a designated cut-off
frequency. Frequencies below the cut-off frequency are rejected or attenuated. Right-click the cell
in the HFF column and select a setting from the menu. The range of values for HFF is 15 Hz to
15 kHz.
7. The Notch filter minimizes and virtually eliminates the interference from nearby electrical
equipment. Right-click the cell in the Notch column to set the Notch filter to Off, 60 Hz or 50 Hz.
8. The sensitivity setting adjusts the sensitivity, or gain, of the channels. Right-click the cell in the
Sensitivity column and select a setting from the menu.
9. The timebase setting adjusts the display and speed of the recording on screen. Right-click a cell
in the Timebase column and select a setting from the menu.
10. Right-click the cell in the Color column to set the color of the trace when it is not active (currently
acquiring data). Red is the default color for active traces.
11. By default, Chime is set to <none>. Right-click the cell in the Chime column to select a sound
from the Chime menu to set a sound for a specific trace.
12. When you are finished setting up traces in the Traces tab, click Save.
13. If you have set a timeline in the Groups tab to interleaving, you should now set the stimulation
delay. To do so, click the Groups tab, then click the Calculate Stim Delay button.
14. Click Save.

K) Markers Tab
Markers and marker definitions and calculations are set up in the Markers tab in the Edit Test window.
When defined, the corresponding Marker buttons appear in the toolbar window next to the Group menu.
Note that:
•

Only one marker of a given type can be placed on a particular set.

•

Markers can be set to mark waveforms and to calculate latency and amplitude values.

•

Markers can be set for each defined group.
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To Set Up the Marker Definitions Table:
1. Click the Append button to add a row to the marker definitions table.
2. Right-click the cell in the Style column and select from:
•
•
•
•
•
•
•

Amplitude
Cursor
Latency Cursor
Tick with Latency Value
Tick with Amplitude Value
Tick with Latency and Amplitude Values
Labeled Tick with Latency Value

3. Then right-click the cell in the Placement column and select from:
•
•
•

Manual
Peak
Trough

When selecting Peak and Trough, enter the appropriate values in the From (ms) and To (ms)
columns.
Note that five milliseconds on either side of the expected latency of the waveform are
generally acceptable.
4. Enter the values in the From (ms) and To (ms) column’s cell to indicate when the marker begins
and ends. The default value is 0 ms and 15 ms respectively.
5. To attach the marker to a specific trace, right-click the cell in the Trace column and select the
trace from the menu displayed.
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Note that you can set up as many markers as required for the test.

To Set Up the Calculations Table:
1. Click the Append button to add a row to the marker calculations table.
2. You can enter a name for the calculated result in the Name column. If a name is not entered,
EPWorks will automatically assign a name based on the markers selected in the From and To
columns.
3. Right-click the From cell to select the second marker. The result is calculated as (To - From).
4. If you plan to select Amplitude in the Type column in Step 3, then right-click the To cell to select
the first marker. -Note that It is not necessary to set a value in the To column, if you select
Latency calculation in the Type column in Step 3.
5. Right-click the Type cell and select either Amplitude or Latency calculation type.
6. Click Save.

L) Reporting Tab

1. The Test-Specific Templates listed in the Template window are applicable to this test.
2. Click the Add button to begin creating your customized Test-specific Template.
3. This box lists the Default Template for the named test. In this example, no default has been
selected from the drop-down list.
4. Click on the Global Templates button to view the list of all available Global Study and Test
Templates (i.e., templates that can be used for any tests).
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Data Acquisition
Types of Recordings
The following types of recordings can be performed with Protektor 32:
•

Somatosenory Evoked Potentials (SSEP)

•

Transcranial Motor Evoked Potentials (TcMEP)

•

Visual Evoked Potentials (VEP)

•

Brainstem Auditory Evoked Potentials (BAEP)

•

Electromyography (EMG)

•

Electroencephalography (EEG)

Live Data Recording Window Overview

1. Live Data Recording View/Window

2. Waveforms Toolbar

3. Title Bar

4. Toolbar

5. Stimulators Window

6. Groups Window

7. Test Directory Window

8. Edit Notes

9. Timebar Overview

10. History Window

In Acquisition, the History window can be viewed while live data is being recorded, thus
allowing you to compare the present waveforms with those collected in previous tests.
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Acquisition Toolbar
See the Toolbar Buttons chapter for the definition of the buttons.

Stimulators Window
The Stimulators Window allows you to set the duration, rate, and intensity of individual stimulators while
the study is on-going.

Groups Window
The Groups window allows you to start and stop the recording of data /acquisition of data. For each
group in your test, the Groups window reports the
number of sweeps accepted (NA column) and the
number of sweeps rejected (NR column) for the
current set being acquired / recorded. To start or
stop acquisition for a specific group, click the check
box in the Type column. For triggered or averaged
groups, you must also start the appropriate stimulator
in the Stimulators window in order to acquire waveforms.
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Waveform Window
The waveform window shows the results of your test in traces and sets of waveforms that are assigned
to groups.
In recording mode, the title bar shows whether the data in the waveform window is Live (currently being
acquired) or Historical (a snapshot of data that was acquired at an earlier point in the study). The
Timebar displays historical data in the waveform window.

1. Title bar shows that this data is Live

2. Group menu is visible if more than one Group
is assigned to the window. The Group menu is
hidden if only one Group is assigned

3. Marker Buttons

4. Sett Calculations

5. Sizing Handle (used to show or hide Set
Calculations).

6.Waveform Label

7. Scroll Bar (used to move window contents
up/down).

8. Sizing Handle (used to make window
larger/smaller).

9. By default a red trace is active.

10. By default a green trace is the baseline.

11. By default a blue trace is selected.

12. Trace Label.

13.Marker

14.Baseline Calculations.

15.ZoomOut/In.
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Waveform Display Mode – Menu Options
To view or change the display mode of a group in a waveform window, right-click a trace label and select
Display Mode from the pop-up menu.
The two main display mode categories are Traces Stack and Sets Stack. You can toggle between
viewing the waveforms in Traces Stack or Sets Stack mode by clicking the first item on the Display
Mode pop-up menu.

1. Trace Label

2. Display Mode Menu

3. Click to change Display Mode from Mode
from Traces Stack to Sets Stack.

Display Mode

Sets Stack

Show All Waveforms

Vertical

Distribute Waveforms

CurveStack

Delete Waveforms

Overlay

Trace Enabled

Replace

Properties…

53

Instructions for Use

XLTEK Protektor32

Traces Display Mode
Waveforms are displayed sequentially in time according to the display mode of the group. A maximum of
50 traces are displayed consecutively. –See below examples of traces Stack. Note that traces can also
be displayed as Sets Stack.
Display Mode

Illustration

Description

Vertical Curve Stack

Single traces

Overlay

Sets of superimposed traces.

Replace

Each new acquired waveform
replaces the previous one.
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Using Markers
To place a marker on a waveform:
1. Select a Marker button.
2. Move the pointer to the desired position and click. The marker is placed on the waveform.
Calculations for the marker appear in the marker calculation results section of the waveform
window.
3. Repeat steps above to place as many markers as required for the test.
•

To Change the Location of a Marker, click the marker on the waveform window and hold down the left
mouse button as you drag the marker to a new location on the waveform. Note that the calculation
results are automatically updated as you move the marker.

•

To delete a Marker, click the marker to select it and then press the Delete key on the keyboard.

Marker Calculations Table
To see the marker calculations table, click the gray bar (sizing handle) and hold down the left mouse
button as you drag the gray bar down.

1. Zoom In/Out Buttons

2. Marker Buttons

3. Marker Calculation Results

4. Sizing Handle (used to show or hide the set
calculations)

5. Marker

6. Active Waveform (red by default)

7. Set 1: Set as the baseline and shown as a
green waveform (by default).

8. Selected Waveform (blue by default)

9. Set B is Baseline Set

10. Group Menu
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To access the Marker Calculation options pop-up menu, right-click a cell in the marker calculations table.
•

Show Absolute Marker Value

•

Show Difference To Baseline

•

Show Percent Difference To Baseline

•

Print Table of Values

--Marker Calculations Table – Options Menu

Measuring Waveforms with Cursors
The Cursors toolbar provides a quick way to measure and compare points on a waveform. Open the
View menu and select Toolbars > Cursors.

Cursors Toolbar
Menu Item

Toolbar
Button

Description

Latency Difference

Measures the time difference in milliseconds from one point on a
waveform to another in the active waveform window (Inter-Peak
Interval).

Amplitude Difference

Measures the difference in voltage of the amplitude between two
points on a waveform in the active waveform window.

Absolute Latency

Measures the time in milliseconds of a particular point on the
waveform in the active waveform window or history window.

Absolute Amplitude

Measures the amplitude voltage of a particular point on the
waveform in the active waveform window as compared to the
baseline.

•

–See Protektor 32 Reference Manual for further description on the Waveform Window Properties:
General Tab; Layout Tab; Misc Tab; Option Menus.
Each trace can have only one baseline waveform. A baseline waveform may belong to
more than one set.
You can enable the option to run multiple stimulators in the Customize: Stimulators Tab.
When running multiple stimulators, electric and external stimulators cannot run at the
same time. Furthermore, no more than one external stimulator can be run at a time.
All other stimulus parameters (Audio: stimulus type, noise type, etc. and Visual: goggles
vs. monitor, color, etc) must be set by opening the Edit Test window and selecting the
AV/Trigger In/Out ports Tab.

56

XLTEK Protektor32

Instructions for Use

To run multiple Timelines at the same time:
1. Open the Stimulators Properties window, select Customize... from the Tools menu and click
the Stimulators tab.
2. Select the Enable running multiple timelines and stims option and click OK.
When you run the test, you will now be able to independently start / stop / pause / continue the timelines.
A timeline clock appears when stimulation is paused for a set interval to show when the stimulation will
restart.

For information on the Timebar, Log Book, and the History window features, see the
Reviewing a Study section.

Impedance Check
The impedance check can be performed at any time during a study. Note that when you check the
impedance, a new Impedance Check note is inserted in the Log Book and on the Timebar.
To perform an Impedance check, follow the steps below:
1. Click the Impedance Check button
on the Settings toolbar.
2. Select the impedance Threshold Value.
3. To check a single channel, select the option next to the desired channel.
To check all of the channels, click the Scan All button.
4. To stop the impedance check and return to the test, click the Exit button.
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EEG / Spectral Windows
EEG Live Window
The EEG Live window displays EEG data according to the currently active montage settings. --Montages
are set up in the Montage tab of the Edit Test window.
You can edit the channel settings temporarily in the settings option menu in the EEG waveform window.
Note that channel settings made with the wavewform setting option menu, do not the settings for the test.

1. Current Time location of the Sweep Edge.

2. Montage Menu

3. Editable Montage Settings

4. Resizable Borders

5. Trace Display

6. Sweep Edge

7. Montage Channels

8. Move Handle

9. Montage Handle Settings

EEG Review Window
The EEG Review window allows you to review all of the EEG data collected during a study.

Reviewing EEG Data
•

Toolbar: Use the Toolbar to navigate through the recorded EEG data.

•

Notes: Notes added during the study are shown in the EEG Review trace display.
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•

Time Mark: You can use the mouse to drag the time mark line to a particular point.

•

Time Stamp: The Time Stamp in the title bar automatically updates to reflect the current position of
the time mark line.

•

Right and Left Arrow Keys: The right and left arrow keys on your keyboard allow you to move the
trace display forward and backward.

•

Timebar: By default, the EEG Review window is linked to the Timebar.

•

When the position of the Timebar slider changes, the EEG Review window is refreshed to display
data from that point in the study.

•

Lock Button: Click the Lock button to toggle the link between the Timebar and the EEG Review
window on and off. When the Lock button is OFF, you can double-click a note on the Timebar to
jump the EEG Review window display to the time in the study where that note was applied.

EEG Review Window Overview

1. Current time location of the Time Mark line.

2. Time Mark line can be dragged with the
mouse.

3. Trace Display

4. Resizable Borders

5. Montage Channels

6. Move Handle

7. Play forward

8. Page forward

9. Stop Play

10. Page Backward

11. Play Backward

12. Select Lock to prevent this window from
being linked to the Timebar Slider position.
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Spectral Window: CSA and DSA EEG
Raw EEG is processed using FFT (Fast Fourier Transform) technique and displaying the EEG spectrum.
The EEG frequency spectra are displayed as Power (μV2) or Amplitude (μV) as a function of frequency.
The Spectral Window displays frequency characteristics of previously defined EEG traces in Compressed
Spectral Analysis or Density Spectral Analysis formats.
The Spectra Settings of the CSA and DSA windows allow you to define their Display, Processing, and
General properties. --To open the CSA/DSA Properties, right-click the background of the CSA/DSA
Window and select Properties....

Compressed Spectral Analysis (CSA) Window

1. Montage Channel Label

2. Frequency Area

3. Time Axis
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Density Spectral Analysis (DSA) Window

1. Montage Channel Label

2. Spectral Edge

3. Frequency Axis

4. Power Axis is shown in the display of color.

5. Time Axis
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Quadrant-DSA Window
The Quadrant Density Spectral Analysis Window displays density spectral analysis groups in quadrants. -To see results in the Quadrant-DSA window, Quadrants must be set in the Edit Test -- Montage tab
window. To open the Quadrant-DSA Properties, right-click the background of the Quadrant DSA
Window and select Properties....
1. Quadrant

2. Time Axis

3. Power Axis Color
Palette

4. Power Axis is shown
in the display of color.

5. Frequency Axis
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Spectral Review Windows
All Spectral Windows –CSA, DSA, Q-DSA– can be viewed in Review mode.

Use the Timebar to move back and forth in time as you Review your Spectral
Window.
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Reviewing a Study
To review a study:
1. Close all active windows by selecting Close Study from the
File menu.
2. Select Review from the File menu.
3. Select a file to review from the Open dialog box.
•

•

If Last study directory is selected in the
Review/Resume section of Customize > Options,
then the most recently acquired study will appear in the File Name field of the Open dialog
box.
If Patients main directory is selected in Customize > Options, you will need to browse for
the patient file that you wish to review. Then double-click the file folder and select the
patient's *.iom file (e.g., John,Smith.iom).

4. Once you have located the file you wish to review, click Open. The study file, in review mode, is
then displayed.
•

To browse for a different file, click the arrow button in the Look in: list box and select the
Patients directory. From the Patients directory displayed, select the file that you wish to
review and click Open.

5. In Review mode, you can:
•
•
•
•
•

Use the Timebar to navigate through the study;
Review the notes in the Log book;
Review calculations in the Trending Window;
Review sets of traces in the History Window;
Review acquired EEG data in the EEG Review Window.

65

Instructions for Use

XLTEK Protektor32

Timebar
The Timebar displays an overview of the entire study allowing you to review it and access its information.
Note that the Timebar feature is available in Recording and Review modes.

Timebar Overview

1. Note Ticks

2. Impedance Check Tick

3. Transition between tests

4. Baseline Tick

5. Slider sits at the point in the study that is
shown in the waveform windows

6. Previous Set
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7. Historical Test Section (Gray)

8. Current Test Section (Yellow)

9 Live Study Section (Aqua)

10. Next Set

11. In Recording mode, the slider jumps back to
live study section. In Review mode, the slider
jumps to the end of the study.
The Timebar can be linked to the following windows:
•

Waveform

•

Log Book

•

History

•

Trending

•

EEG Review

By default, all of the above windows (except History) are linked to the Timebar
To enable/disable the link, use the option menu or the Timebar toolbar button.
The Timebar displays:
•

All tests that have been used in the course of a study including active (currently live) and inactive
(historical) tests.

•

All of the notes in a study.

•

Baselines

•

Impedance checks
When you left-click the Timebar, a watch symbol appears beside the pointer. Note that if you
hold down the left-mouse button, the Timebar will not be updated until you release it.

To see an information box about any point on the timeline, roll the pointer
over the area or click a point of interest.
For information on Timebar Navigation Buttons; Timebar Option Menus; Timebar Ticks;
see Protektor 32 Reference Manual.
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Log Book
The Log Book keeps a record of all notes that are added to the test, as well as the particular waveform, if
any, that each note is associated with.
Note that the Log Book feature is also available in Recording mode.

1. Note that pertains to whole test.

2. Note that is attached to the waveform.

3. Time that the note was applied.

4. For notes linked to waveforms, shows the trace
label, set number and acquisition time.

5. Drag the line between headings left or
right to change the width of a column.

6. Add a general note to the test by selecting from the
Notes menu or creating a custom note.

7. Delete a note

8. Open the Edit Notes dialog box to change the title,
add comments or link the note to a waveform.
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Trending Window Overview
The Trending window is used to display ordered sequences of calculations for the markers on each of
your tests.

1. Trending Display Configuration button:
Currently set to display All Calculations. Click to
narrow the display to specific groups or markers.

2. Sets number of minutes of data displayed in the
graphs.

3. Graphic is set to points display type.

4. Graphic is set to vertical bars display type.

5. Reading Gap is compacted and framed by
dotted blue lines.

6. Move the Scroll box left or right to view more
data.

7. Status bar messages change according to the
position of the mouse pointer.

8. Delimeter Bar

9. Graph Titles show Marker Label <Group
Title>.

10. Red graph heading shows that graph points
exceed user’s allowed level.

11. Graph points show marker calculation for
each set.

12. Time Scale
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13. Red triangle exceeds user’s defined levels. –
i.e., “Out of Range Level”.

14. Go to Previous Note.

History Window Overview
The History window allows you to review all of the waveforms/traces that were acquired over the course
of a study, including those that were deleted when the maximum number of sets for a waveform window
was reached.
The waveform baseline will be shown with the most recently acquired waveform visible right above it.
Note that in Review, the History window can be enabled allowing you to compare
present data with previously recorded tests.

History Window – All Traces

1

Refresh/Stop Button

9

Cursor (marker) calculations are green (by default).

2

Status Box currently shows Time Scale
Start Time

10

Reading Gap

3

History Display Configuration Selection
Button

11

Move the scroll box left or right to view more data
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4

Time Scale Size

12

Status bar messages change according to the
position of the mouse pointer.

5

Toggle time scale units between minutes
and seconds.

13

Move display to end of time scale.

6

Adjust All Gains

14

Step start of time scale forward.

7

Float Notes

15

Step start of time scale back.

8

Waveforms are yellow (by default).

16

Move display to beginning of time scale.
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Reports
Creating Generic Reports
Each EPWorks Report is generated using two different types of Reporting Template:
•
•

Study Template: includes information inserted from the Patient Study
−e.g., Patient Information and Case Summary.
Test Template: includes collected data from your Patient Study
−e.g., waveforms and calculation tables for each group.

After you have completed a Patient Study, click the Reporting button
on the toolbar. From the
Select Report Templates list, select the tests that you wish to include in your Report and click OK. Your
Report will then be generated.
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Remote Monitoring
Before You Begin
Before you can begin using XLTEK Portals software (i.e. LocalPortal and RemotePortal), consult your
hospital or institution's IT department to configure the appropriate IP addresses, subnet masks and
default gateways.
To verify that all your computers are connected and that you will be able to run XLTEK Portals software
successfully, it is advisable to run Microsoft Netmeeting first.
To open Microsoft Netmeeting, go to:
Start > Programs > Accessories > Communications
To adjust your Audio and Video parameters, select:
1) Adjusting Audio Parameters for Remote Monitoring
2) Adjusting Video Parameters for Remote Monitoring
Once you have run NetMeeting successfully and adjusted your Audio and Video parameters, you are
ready to start using XLTEK LocalPortals (on the Acquisition System) and RemotePortals software (on the
Remote System) and begin Remote Monitoring.

XLTEK Portals
LocalPortal
LocalPortal is the XLTEK Remote Monitoring software that is run on the Local or Acquisition Station (i.e.
the computer that is acquiring the patient data). This software enables data to be sent to one or more
Remote Monitoring Stations (i.e. to computers that are observing the Acquisition Station).
To open the LocalPortal software, go to Start > Programs > XLTEK and select Local Portal.
It is important that you properly configure your LocalPortal software to optimize the performance of your
Remote Monitoring capability.

RemotePortal
RemotePortal is XLTEK's Remote Monitoring software that is run on the Remote Station (i.e. the
computer that remotely observes the Acquisition Station). The RemotePortal software enables the
Remote Station to receive live waveforms (EP, free run EMG, triggered EMG, EEG) as well as historical
waveforms. The software also supports the transmission of text messages.
To open the RemotePortal software, go to Start > Programs > XLTEK and select Remote Portal.
In Options, under Nickname, specify the name that the Acquisition Station will see.
When right-clicking the name of an Acquisition Station in your list, an information box with details about
the case currently being acquired will appear over the Remote Portal window. To remove the information
box from the screen, click on it with your mouse.
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Multiple Connections
You can monitor more than one Acquisition Station by more than one Remote Station. The following
configurations below are the available:
Both Local Portal (LP) and Remote Portal (RP) can run on the same station at the same time.
•

RP can connect to several acquisition stations (nLP) and monitor them at the same time (one-tomany monitoring).

•

LP can accept several observers (nRP) at the same time (many-to-one monitoring).

•

Above three points give many-to-many monitoring where all topologies (including loops) are allowed.

•

LP-nRP textual chat.

Additional Information and Terms
Bandwidth – is the total amount of EPWorks data being sent to the observer (the units are in
bytes/second
•

Messages – refers to how many messages per second are being sent to the observer (data is
passed in messages)

•

Queue – refers to how many messages are currently in the process of going across to the observer

•

Remote monitoring Optimizations – These are all optimizations that can reduce system load and
network load both on the acquisition system and the remote system
•
•
•

SSEP by default, not every single “intermediate” sweep is send of an averaged waveform in
order to save bandwidth. The user can specify how frequently the intermediate sweeps are
sent (final completed sweeps are always sent).
Update free run EMG every n seconds – this saves network bandwidth by sending sweeps
every few seconds. The user can specify 0 and it will send the data as soon as they have it.
Accumulated EEG – this specifies how “smoothly” the EEG on the remote system will be
displayed. The more frequently it is sent, the more the network bandwidth it will use.

•

Remote Monitoring – Physician will be able to add notes directly into the patient record “log book”
while connected remotely.

•

Connectivity – a message will appear on both the acquisition system and the remote monitoring
system if a network connection is lost and also when the connection is reestablished..
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Video Microscope
A video of the microscope feed can be obtained by connecting the Protektor32 Microscope Integration
Kit.
To open the microscope view click View tab and then Microscope. Once the video is displayed you will
have the option to record video segments up to 10 minutes at a time. To record, click on the red record
button on the bottom left of the screen. Both the start and stop time of the video clip will be displayed in
the “Log Book”.
To replay the recording, double click on the video clip of interest in the “Log Book” and click the play/stop
button located in the time bar on the bottom of the video.
The video image will appear if you take a screen shot.
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Toolbar Buttons
Toolbar

Button

Description
Averager On/Off

Controls

Free Run Acquisition On/Off
Triggered Acquisition On/Off
Stop All Stimulators.

Sets

Delete Set and Restart Averager
Keep Current Set.
Latency Difference Cursor

Cursors

Amplitude Difference Cursor
Absolute Latency Cursor
Absolute Amplitude Cursor
Study Information

Customize

Create Report
Customize

Settings

Impedance Test.
Edit Test
Record Layout.

Layouts

Select Layout.
Sound On/Off Mute

Volume

Increase /Decrease Sound
Current Screen Snapshot

Camera
Select Snapshot.
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Accessories
Protektor32 systems can be used with the following types of electrodes:
•

Disc Electrodes

•

Needle Electrodes

•

Bar Electrodes

•

Pedicle Screw Probe

•

Corkscrew Electrodes

EEG accessories which can be used with the Protektor32 amplifier are available for you to browse the
Natus Neuro Catalog online at www.natus.com or call Natus Sales and Support at 1-800-303-0306. The
following are compatible accessories:
Part Number

Description

002514

P32 - TCMEP Pod (Cr)

002978

Protektor 32 - Isolation Box

002979

Protektor 32 - Stimulation Box

002980

Protektor 32 - Acquisition Box

003708

Probe Pod - P32 (Cr)

005030

P32 Cautery Detector (Cr)

005031

Protektor 32 Visual Stim LED Goggles

010384

P32 Pulse Oxi LP Cable(Cr)

006640

P32 POWER SUPPLY

005562

P32 Ear Inserts (Cr)

W8194X

USB 2.0 6FT HI SPEED GOLD

A1011X

Power Cord, Unshielded, 10ft

005032

P32 AUDITORY STIM HEADPHONES

005029

PROTEKTOR 32 TRIGGER I/O CABLE (Cr)

004878

PROTEKTOR 32 STRAP WITH HOOKS
WARNING: The use of accessories, transducers, or cables other than those specified or
provided by Xltek could result in increased electromagnetic emissions or decreased
electromagnetic immunity of this equipment and result in improper operation.
The Protektor32 headbox accepts only touch-proof style electrode inputs. Do not
attempt to use any other style of patient electrode input.
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The Protektor32 must be used only with legally marketed electrodes in the country
where in use. For instance, in the United-States use only FDA approved, legally
marketed electrodes. In Canada use only Health Canada approved legally-marketed
electrodes; in EU countries use only CE approved legally marketed electrodes.
All electrodes in a single patient setup should be made of the same metal. Do not use
two different or dissimilar types of metals in a single setup.
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A total service solution
Standing behind every Xltek product is Natus Medical Incorporated, an internationally respected innovator
of medical products and services.
Our Neurology systems are backed up by an in-house support team staffed with technical and clinical
experts, 24/7 support, remote support via WebEx or VPN, the largest clinical and technical field support
network in Neuro/Sleep and customized service contracts that include preventative maintenance visits
and computer upgrades.

Natus Medical Incorporated
DBA Excel-Tech Ltd. (XLTEK)
2568 Bristol Circle
Oakville, Ontario
L6H 5S1 Canada
T: +1 905.829.5300
F: +1 905.829.5304
natus.com
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